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1.1  Introduction

This manual contains the installation, configuration, and operation instruc-
tions for the PESA Virtual Control Panel. Please refer to this manual prior
to installing and operating the PESA Virtual Control Panel.

General

The PESA Virtual Control Panel provides a wide range of powerful control
options. Hot take, audio-follow-video, break-away, and salvo switches are
available at the click of mouse button. Additionally, a selected source can
be switched to a single destination or a group of destinations (gang).
Single or multiple destinations can be locked or unlocked from the Virtual
Control Panel. The salvo capability allows the custom building of multiple
switches through an intuitive drag and drop interface screen (PESA Virtual
Panel Preset Screen). Multiple salvos and panel configurations (PESA
Virtual Panel Configuration Screen) can be saved (stored) to disk and
recalled as needed.  Additionally, the PESA Virtual Control Panel can be
configured to automatically establish a communications link with remotely
located switching systems.  The communications link can be configured
and established using a wide variety of industry standard modems.

The following topics are discussed in this manual:

• Virtual Panel Installation
• Software License Agreement
• Virtual Panel Configuration
• Example System Configuration
• Virtual Panel Operation

NOTE

The PESA Virtual Panel is designed to be installed on and function on PC running Win-
dows 95™ or Windows NT™.  The PESA Virtual will not function on a PC running Win-
dows 3.1™.

NOTICE

THE PESA VIRTUAL PANEL SOFTWARE PACKAGE INSTALLATION, CONFIGURA-
TION, AND OPERATION PROCEDURES FOUND IN THIS MANUAL MODULE ARE NOT
MEANT TO BE A REPLACEMENT FOR A THOROUGH KNOWLEDGE OF WINDOWS™
OPERATING SYSTEMS. PESA VIRTUAL PANEL USERS SHOULD HAVE A CONCEP-
TUAL UNDERSTANDING OF THE WINDOWS™ OPERATING SYSTEM.
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2.1  Virtual Panel Installation

The installation of the PESA Virtual Panel is a step-by-step process simi-
lar to the installation of any Windows™ based software package. The
following paragraphs outline the steps necessary to properly install the
PESA Virtual Panel Software.

To install the PESA Virtual Panel Software, access the Run Screen as
shown in Figure 2-1. The Run Screen is available from the Start Button.
Once the Run Screen is accessed, type in A:\VPSETUP.EXE or
B:\VPSETUP.EXE in the Open Data Field, depending upon which floppy
drive is a 3.5" drive. Once the entry in the data field is completed, place
Disk 1 of the PESA Virtual Control Panel Software Package in the desig-
nated floppy drive and select OK to proceed with the installation.

Figure 2-1 Run Screen

Once OK is selected on the Run Screen, the PESA Virtual Panel Installa-
tion Program will start.  Follow the on-screen instructions to continue the
installation process.
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Once the installation process is completed, the  PESA Virtual Panel Short-
cut Icon should be displayed on the desktop of the system computer as
shown in Figure 2-2.

Figure 2-2 PESA Virtual Panel Shortcut Icon

The PESA Virtual Panel Program Group, which contains the PESA Virtual
Panel, Virtual Panel Configuration, and PESA Virtual Panel Help, is ac-
cessible through the Start Programs function of Windows™ once the
installation program is completed (Figure 2-3). To start one of the pro-
grams contained in the PESA Virtual Panel Group, select the desired
program and click on it.

Figure 2-3 PESA Virtual Panel Program Group

2.1  Virtual Panel Installation Continued:
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3.1  Software License Agreement

BY CLICKING ON THE "ACCEPT" BUTTON OR OPENING THE PACKAGE, YOU ARE
CONSENTING TO BE BOUND BY THIS AGREEMENT. IF YOU DO NOT AGREE TO ALL
OF THE TERMS OF THIS AGREEMENT, CLICK THE "REJECT" BUTTON AND THE
INSTALLATION PROCESS WILL NOT CONTINUE.

PESA VIRTUAL PANEL END USER COMMERCIAL LICENSE AGREEMENT

GRANT.

Subject to purchase of a PESA System Controller, PESA Switching Systems, Inc. (PESA)
grants to you a non-exclusive license to use the Software and accompanying documenta-
tion ("Documentation") in the manner described  below under "Scope of Grant."

LIMITED WARRANTY.

PESA warrants that for a period of ninety (90) days from the date of acquisition, the Soft-
ware, if operated as directed, will substantially achieve the functionality described in the
Documentation. PESA does not warrant, however, that your use of the Software will be
uninterrupted or that the operation of the Software will be error-free or secure. In addition,
the security mechanisms implemented by PESA software have inherent limitations, and
you must determine that the Software sufficiently meets your requirements.  PESA also
warrants that the media containing the Software, if provided by PESA, is free from defects
in material and workmanship and will so remain for ninety (90) days from the date you
acquired the Software. PESA's sole liability for any breach of this warranty shall be, in
PESA's sole discretion: (i) to replace your defective media; or (ii) to advise you how to
achieve substantially the same functionality with the Software as described in the Docu-
mentation through a procedure different from that set forth in the Documentation; or (iii) if
the above remedies are impracticable, to refund the purchase price you paid for the Sys-
tem Controller. Repaired, corrected, or replaced Software and Documentation shall be
covered by this limited warranty for the period remaining under the warranty that covered
the original Software, or if longer, for thirty (30) days after the date (a) of shipment to you of
the repaired or replaced Software, or (b) PESA advised you how to operate the Software
so as to achieve the functionality described in the Documentation. Only if you inform PESA
of your problem with the Software during the applicable warranty period and provide evi-
dence of the date you purchased a license to the Software will PESA be obligated to honor
this warranty. PESA will use reasonable commercial efforts to repair, replace, advise or, for
individual consumers, refund pursuant to the foregoing warranty within 30 days of being so
notified.
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THIS IS A LIMITED WARRANTY AND IT IS THE ONLY WARRANTY MADE BY PESA.
PESA MAKES NO OTHER EXPRESS WARRANTY AND NO WARRANTY OF
NONINFRINGEMENT OF THIRD PARTIES' RIGHTS. THE DURATION OF IMPLIED
WARRANTIES, INCLUDING WITHOUT LIMITATION, WARRANTIES OF MERCHANT-
ABILITY AND OF FITNESS FOR A PARTICULAR PURPOSE, IS LIMITED TO THE
ABOVE LIMITED WARRANTY PERIOD; SOME JURISDICTIONS DO NOT ALLOW LIMI-
TATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, SO LIMITATIONS MAY
NOT APPLY TO YOU. NO PESA DEALER, AGENT, OR EMPLOYEE IS AUTHORIZED
TO MAKE ANY MODIFICATIONS, EXTENSIONS, OR ADDITIONS TO THIS WARRANTY.
If any modifications are made to the Software by you during the warranty period; if the
media is subjected to accident, abuse, or improper use; or if you violate the terms of this
Agreement, then this warranty shall immediately be terminated. This warranty shall not
apply if the Software is used on or in conjunction with hardware or software other than the
unmodified version of hardware and software with which the software was designed to be
used as described in the Documentation.  THIS WARRANTY GIVES YOU SPECIFIC
LEGAL RIGHTS, AND YOU MAY HAVE OTHER LEGAL RIGHTS THAT VARY BY JURIS-
DICTION.

SCOPE OF GRANT.

You may:
* use the Software on any single computer;
* use the Software on a second computer so long as only one copy is used at a time;
* copy the Software for archival purposes, provided any copy must contain all of the original
Software's proprietary notices.

You may not:
* permit other individuals to use the Software except under the terms listed above;
* permit concurrent use of the Software;
* modify, translate, reverse engineer, decompile, disassemble (except to the extent appli-
cable laws specifically prohibit such restriction), or create derivative works based on the
Software;
* copy the Software other than as specified above;
* rent, lease, grant a security interest in, or otherwise transfer  rights to the Software; or
* remove any proprietary  notices or labels on the Software.

TITLE.

Title, ownership rights, and intellectual property rights in the Software shall remain in PESA
and/or its suppliers. The Software is protected by the copyright laws and treaties.  Title and
related rights in the content accessed through the Software is the property of the applicable
content owner and may be protected by applicable law. This License gives you no rights to
such content.

3.1  Software License Agreement Continued:
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TERMINATION.

The license will terminate automatically if you fail to comply with the limitations described
herein.  On termination, you must destroy all copies of the Software and Documentation.

LIMITATION OF LIABILITY. UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL
THEORY, TORT, CONTRACT, OR OTHERWISE, SHALL PESA OR ITS SUPPLIERS OR
RESELLERS BE LIABLE TO YOU OR ANY OTHER PERSON FOR ANY INDIRECT,
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER IN-
CLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF GOODWILL, WORK
STOPPAGE, COMPUTER FAILURE OR MALFUNCTION, OR ANY AND ALL OTHER
COMMERCIAL DAMAGES OR LOSSES. IN NO EVENT WILL PESA BE LIABLE FOR
ANY DAMAGES IN EXCESS OF THE AMOUNT PESA RECEIVED FROM YOU FOR A
LICENSE TO THE SOFTWARE, EVEN IF PESA SHALL HAVE BEEN INFORMED OF
THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY.
THIS LIMITATION OF LIABILITY SHALL NOT APPLY TO LIABILITY FOR DEATH OR
PERSONAL INJURY TO THE EXTENT APPLICABLE LAW PROHIBITS SUCH LIMITA-
TION. FURTHERMORE, SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR
LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THIS LIMITATION
AND EXCLUSION MAY NOT APPLY TO YOU.

MISCELLANEOUS.

If the copy of the Software you received was accompanied by a printed or other form of
"hard-copy" End User License Agreement whose terms vary from this Agreement, then the
hard-copy End User License Agreement governs your use of the Software.  This Agree-
ment represents the complete agreement concerning this license and may be amended
only by a writing executed by both parties. THE ACCEPTANCE OF ANY PURCHASE
ORDER PLACED BY YOU IS EXPRESSLY MADE CONDITIONAL ON YOUR ASSENT
TO THE TERMS SET FORTH HEREIN, AND NOT THOSE IN YOUR PURCHASE OR-
DER. If any provision of this Agreement is held to be unenforceable, such provision shall
be reformed only to the extent necessary to make it enforceable.  This Agreement shall be
governed by Alabama law (except for conflict of law provisions).

3.1  Software License Agreement Continued:
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4.1  Introduction

To open the Virtual Panel Configuration Utility, select and click on Virtual
Panel Configuration in the PESA Virtual Panel Group. The Virtual Panel
Configuration Utility enables the user to quickly build, edit, save, and open
multiple PESA Virtual Panel configurations. Selecting and clicking on
Virtual Panel Configuration will open the Virtual Panel Configuration Utility
Screen (Figure 4-1).

Figure 4-1 Virtual Panel Configuration Screen

The tabs on the Virtual Panel Configuration Utility Screen enable the entry
and configuration of system controllers, levels, sources, destinations, and
name sets (name sets consist of logical sets of sources and destinations).
Additionally, each source and destination can be given a logical name up
to eight alpha-numeric characters long including spaces.
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4.2  Configuration Menus

The main configuration menus on the Virtual Panel Configuration Screen
are File and Help. The File Menu provides access to the New, Open,
Save, Load Default Configuration, and Exit configuration functions (Figure
4-2). The Help Menu provides access to the Contents and About functions
(Figure 4-3).

Figure 4-2 File Menu Functions

Figure 4-3 Help Menu Functions

New

Selecting New in the File Menu will open a blank Virtual Panel Configura-
tion Screen as shown in Figure 4-4. The blank configuration screen en-
ables the user to build a new PESA Virtual Panel Configuration by enter-
ing the desired configuration information on the proper tab page and into
designated data fields. For help in building a new configuration refer to the
Example Configuration Section of this manual.
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Figure 4-4 Blank Virtual Panel Configuration Utility Screen

Open

Selecting Open in the File Menu will cause  the Open Screen (Figure 4-5)
to be displayed. The Open Screen enables the user to open existing
Virtual Panel Configurations into the Virtual Panel Configuration Screen.
The existing configuration can then be viewed and edited if desired.

To open the desired configuration, click on the desired configuration name
or type in the desired configuration name into the File Name Data Field
and select Open. Selecting Cancel will abort the file open operation and
will return you to the Virtual Panel Configuration Utility Screen.

4.2  Configuration Menus Continued:

New Continued:
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Figure 4-5 Open Screen

Save

Selecting Save from the File Menu will cause the Save As Screen (Figure
4-6) to be displayed. The Save As Screen enables the user to save the
current configuration's information onto a floppy drive or hard-drive for
convenient retrieval as needed. The configuration information can either
be saved in an existing configuration file or in a new user assigned con-
figuration file. To save the current configuration to a new file, enter the
desired file name in the File Name Data Field and select Save. Please
note that the default save directory is the PESAVP Directory. If you wish
to save the current configuration in a directory other than the default
directory, please select the desired directory. To save the current configu-
ration to an existing file name, click on the existing file name and then
select Save.

4.2  Configuration Menus Continued:

Open Continued:
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Figure 4-6 Save As Screen

If the current configuration is being saved into an existing file name, the
Save As Information Screen will be displayed prior to the configuration
information being saved. If you definitely want to replace the existing
configuration's file information with the current configuration's information,
select Yes. Selecting No will return you to the Save As Screen without
making any changes to the selected configuration file.

Figure 4-7 Save As Information Screen

4.2  Configuration Menus Continued:

Save Continued:
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Once the current configuration's information is saved to the selected file,
the Save Completed Screen (Figure 4-8) will be displayed. Select OK on
the Save Completed Screen to make the current configuration (the con-
figuration that was saved) the default configuration and return you to the
Virtual Panel Configuration Screen. If OK is selected, the next time the
PESA Virtual Panel Program is started, it will load the default configura-
tion. Selecting Cancel will return you to the Virtual Panel Configuration
Screen without making the current configuration the default configuration.

Figure 4-8 Save Completed Screen

Load Default

Selecting Load Default from the File Menu will cause the Load Default
Screen (Figure 4-9) to be opened. To load the default configuration into
the Virtual Panel Configuration Screen, select OK. Any existing configura-
tion information listed on the Virtual Panel Configuration Screen will be
over-written by the default configuration's information. The default configu-
ration is simply a general configuration representing a PESA Routing
Switcher System. Selecting Cancel will return you to the Virtual Panel
Configuration Screen without any configuration change actions taking
place.

Figure 4-9 Load Default Screen

4.2  Configuration Menus Continued:

Save Continued:
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Exit

Selecting Exit from the File Menu will exit you from the Virtual Panel
Configuration Program and return you the Windows™ desktop.

Contents

Selecting Contents from the Help Menu will open the PESA Virtual Panel
Help File Screen. The PESA Virtual Panel Help File functions in the same
manner as the majority of Windows™ help files. Once you are through
referencing the help file, select File and Exit to return to the PESA Virtual
Panel Configuration Utility Screen.

About

Selecting About from the Help Menu will open the Virtual Panel Configura-
tion Utility Information Screen. The Virtual Panel Configuration Utility
Information Screen  displays copyright and version information. To return
to the Virtual Panel Configuration Utility Screen, select OK.

4.3  Configuration Tabs

There are five configuration tabs on the Virtual Panel Configuration
Screen which allow the user to configure the controllers, levels, sources,
destinations, and name sets which make-up a complete virtual panel
configuration.  The number of configurable controllers, levels, sources,
destinations, and name sets are only limited by the physical configuration
of the user's routing switcher system and by type routing switcher system
controller being utilized.  The following paragraphs describe each of the
configuration tabs and their related data entry fields.

NOTE:  The data tables and corresponding data fields on the configura-
tion tabs are selectable and up-datable using standard Windows™ key-
strokes and mouse actions.  Please also note that invalid data field entries
not allowed and are  alerted by a corresponding error message.

4.2  Configuration Menus Continued:
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Controllers

The data fields available on the Controller Tab are Controller, Controller
Address, Number of Levels, and Delete (Figure 4-10). The Controller Data
Field allows the entry of a logical controller name up to eight alpha-nu-
meric characters long.  The Controller Address Data Field allows the entry
of a numeric address from 0 to 255.  The selection of address 0 limits the
configuration of the PESA Virtual Panel to one system controller.  The
Number of Levels Data Field enables the number of desired configuration
levels consistent with the type of system controller being utilized. Selec-
tion of the Delete Data Field marks configuration items (controllers) to be
deleted when Apply is selected or when another tab is selected.  Control-
ler names and addresses must be unique.

To configure a controller, enter the desired controller name, controller
address, and number of levels in the correct data fields.  Please note that
as controller configurations are entered the Controller Tab Data Table
automatically expands to allow the entry of more configuration items.

Figure 4-10  Controllers Tab

4.3  Configuration Tabs Continued:
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Levels

The data fields available on the Levels Tab are the Levels, Number,
Controller, Levels Offset, Number of Inputs, Number of Outputs, and
Delete (Figure 4-11).  The Level Data Field allows the entry of an alpha-
numeric name, up to eight characters long, for each configured level.
Please note that all levels names must be unique.  The Number Data
Field allows the entry of a level number.  If a level number is not assigned
the next available number will be automatically assigned.  Please note
that all level numbers must be unique.  The Controller Data Field allows
the selection of an previously configured controller; either from the scroll-
down controllers list or by typing the desired controller's assigned name.
The Level Offset Data Field indicates the level offset for the controller that
is associated with the respective level.  The assigned level offset must be
unique per controller.  The Number of Inputs Data Field allows the assign-
ment  of the number inputs which will be controlled on the configured
level.  The assigned number of inputs should match the number of valid
physical inputs which can be controlled on the corresponding level.  The
Number of Outputs Data Field allows the assignment  of the number
outputs which will be controlled on the configured level.  The assigned
number of outputs should match the number of valid physical inputs which
can be controlled on the corresponding level.  Selection of the Delete Data
Field marks configuration items (levels) to be deleted when Apply is se-
lected or when another tab is selected.

To configure a level, enter the desired level name, number, controller
selection, level offset, number of inputs, and number of outputs in the
correct data fields.  Please note that as level configurations are entered
the Levels Tab Data Table automatically expands to allow the entry of
more configuration items.

4.3  Configuration Tabs Continued:
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Figure 4-11 Levels Tab

Sources

The data fields available on the Source Tab are Source, a data field corre-
sponding to each configured level, and Delete.  The Source Data Field
allows the configuration of sources and assignment of an alpha-numeric
source name, up to eight characters long, to each configured source.  The
Level Entry Data Fields allow the assignment of input numbers to each
configured source on each configured level.  Please note the input num-
ber "0" equates to an input number not being assigned to a configured
source on a selected level.  Selection of the Delete Data Field marks
configuration items (sources) to be deleted when Apply is selected or
when another tab is selected.

4.3  Configuration Tabs Continued:

Levels Continued:
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To configure a source, enter the desired unique source name and the
input number to be assigned to each configured level in the correct data
fields.  Please note that as source configurations are entered the Sources
Tab Data Table automatically expands to allow the entry of more configu-
ration items.

Figure 4-12 Sources Tab

Destinations

The data fields available on the Destination Tab are Destination, a data
field corresponding to each configured level, and Delete.  The Destination
Data Field allows the configuration of destinations and assignment of an
alpha-numeric destination name, up to eight characters long, to each
configured destination.  The Level Entry Data Fields allow the assignment
of output numbers to each configured destination on each configured
level.

4.3  Configuration Tabs Continued:

Sources Continued:
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Please note the output number "0" equates to an output number not being
assigned to a configured destination on a selected level.  Outputs for a
destination must be unique per level; i.e. two destinations may not share
the same output on the same level.  Selection of the Delete Data Field
marks configuration items (destinations) to be deleted when Apply is
selected or when another tab is selected.

To configure a destination, enter the desired unique destination name and
the destination number to be assigned to each configured level in the
correct data fields.  Please note that as destinations configurations are
entered the Destinations Tab Data Table automatically expands to allow
the entry of more configuration items.

Figure 4-13  Destinations Tab

4.3  Configuration Tabs Continued:

Destinations Continued:
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Names Sets

The data fields available on the Name Sets Tab are Name Set and Delete.
The Name Sets Tab also provides a Sources List and Destinations List to
enable the quick building of Name Sets.  The Group Name List displays
the sources and destinations contained within the selected Name Set. The
commands available on the Name Sets Tab are Add, Clear, and Delete.

The Name Set Data Field allows the configuration of a name set and the
assignment of a unique alpha-numeric name, up to eight characters long,
to each configured name set.  Selection of the Delete Data Field enables
the deletion of the corresponding name set.

The Add command allows the addition of selected source and destinations
to the selected name set.  The Clear command enables the clearing of the
selection of sources and destinations.  The Delete command enables the
deletion of selected sources and destinations from the selected name set.

To configure a name set, enter the desired name set name in the correct
data field.  Once the name set name is entered, select the sources and
destinations that will comprise the selected name set's configuration from
the sources and destinations lists and select Add.  When Add is selected,
the Group Name List will be updated to display the selected sources and
destinations.

4.3  Configuration Tabs Continued:
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Figure 4-14 Name Sets Tab

4.4  Configuration Commands

The following paragraphs describe the commands available on the Virtual
Panel Configuration Screen.  Please note that the following commands
are not available on the Name Set Tab.

4.3  Configuration Tabs Continued:

Names Sets Continued:
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Apply

Selecting the Apply command causes any configuration changes or edits
on the current tab to be included as part of the current (open) configura-
tion.  For example, if an additional level is added to the current configura-
tion and another tab has not been selected, selecting Apply will update
the current configuration to include the new level configuration.  The
current changes are also updated and included into the current (open)
configuration when another tab is selected.  To store changes perma-
nently, the user must select Save from the File Menu.

Cancel

Selecting the Cancel command will cancel any configuration changes to
the current configuration providing another tab has not been selected prior
to selecting Cancel.

4.5  PESA VP Configuration Conceptual Overview

The PESA Virtual Panel is a Windows™ based control panel that allows
the user to control a PESA Routing Switcher System from a PC.  The PC
connects to the PESA Routing Switcher over a serial link (RS-232 or RS-
422) using the PESA Routing Switcher Controller's CPU link interface.
The PESA Virtual Panel can be used with any routing switcher system
that supports the standard PESA CPU Link Protocol #1.

The PESA Virtual Panel can be configured for single or multiple control-
lers.  It can map router inputs and outputs into different sources and
destinations providing optimal usage of the router.  Sources and destina-
tions may be organized into different name sets due to their location,
signal type or for any other reason the user requires.  Through name sets,
users may view and control only selected sources and destinations at one
time.

The following scenarios provide examples of how to configure two differ-
ent systems.

4.4  Configuration Commands
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Single Ocelot Configuration

A single 8X8 Ocelot configuration may include 4 levels: Analog-Video,
Analog-Audio, Digital-Video and Digital-Audio.  In this example, the user
wants to control the audio and digital as separate items even though they
are resident on the same Ocelot system.

This results in the following configuration.

Controller Tab
RELLORTNOC SSERDDARELLORTNOC SLEVELFOREBMUN

LTNC 0 4

Notes: The Controller Address of 0 indicates that this configuration is for a
single controller.

Level Tab

LEVEL
LEVEL
REBMUN

RELLORTNOC
LEVEL
TESFFO

FOREBMUN
STUPNI

FOREBMUN
STUPTUO

DIV-A 1 LTNC 1 8 8

DUA-A 2 LTNC 2 8 8

DIV-D 3 LTNC 3 8 8

DUA-D 4 LTNC 4 8 8

Note:  CNTL1 has 4 levels, therefore there is a level offset for each level
associated with the  controller.

4.5  PESA VP Configuration Conceptual Overview Cont:
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Source Tab
ECRUOS DIV-A DUA-A DIV-D DUA-D

1CSRA 1 1 0 0

2CRSA 2 2 0 0

: : : : :

8CRSA 8 8 0 0

1CRSD 0 0 1 1

2CRSD 0 0 2 2

: : : : :

8CRSD 0 0 8 8

These represent the feeds that are incoming into the routing switcher.
Note that they are setup so the sources are divided between those with
digital signals and those with analog signals.  (Note:  0 as an input indi-
cates that the source is not defined on that level. )

Destination Tab
NOITANITSED DIV-A DUA-A DIV-D DUA-D

1TSDA 1 1 0 0

2TSDA 2 2 0 0

: : : : :

8TSDA 8 8 0 0

1TSDD 0 0 1 1

2TSDD 0 0 2 2

: : : : :

8TSDD 0 0 8 8

These represent the feeds that are driven from the routing switcher.  As
with the sources, the destinations are divided between those with digital
signals and those with analog signals.  (Note: 0 as an input indicates that
the Destination is not defined on that level.)

4.5  PESA VP Configuration Conceptual Overview Cont:

Single Ocelot Configuration Continued:
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Name Set Tab

TESEMANGOLANA

EMANPUORG EPYT

1CRSA CRS

2CRSA CRS

: :

8CRSA CRS

1TSDA TSD

2TSDA TSD

: :

8TSDA TSD

TESEMANLATIGID

EMANPUORG EPYT

1CRSD CRS

2CRSD CRS

: :

8CRSD CRS

1TSDD TSD

2TSDD TSD

: :

8TSDD TSD

4.5  PESA VP Configuration Conceptual Overview Cont:

Single Ocelot Configuration Continued:
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TESEMANLLA

EMANPUORG EPYT

1CRSA CRS

2CRSA CRS

: :

8CRSA CRS

1CRSD CRS

2CRSD CRS

: :

8CRSD CRS

1TSDA TSD

2TSDA TSD

: :

8TSDA TSD

1TSDD TSD

2TSDD TSD

: :

8TSDD TSD

Name Sets allow the user to restrict the sources and destinations that the
user sees on the PESA Virtual Panel at any one time.  This reduces the
clutter that a user may have to deal with when they are controlling the
router.  In this instance, the user can display only the digital sources and
destinations by selecting the DIGITAL Name Set.  The same occurs as
well with the ANALOG Name Set.   The ALL Name Set is a convenience
that allows the user to show activity of all sources and destinations.

4.5  PESA VP Configuration Conceptual Overview Cont:

Single Ocelot Configuration Continued:
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Multiple Ocelot Configuration

The PESA Virtual Panel has the capability of simultaneously controlling
multiple controllers across a single RS-422 link.  PESA's Ocelot, Bobcat,
and LNS routing switchers support this multi-drop feature in their CPU link
configurations.

A multiple controller configuration might include two Ocelot Controllers
with the first having three levels and the second having four levels.  These
Ocelot Controllers might be located in two different rooms, Rooms A and
B.  From a single instance of the PESA Virtual Panel, the user can control
the routing switching system in either room at the same time.

This might result in the following configuration.

Controller Tab
RELLORTNOC SSERDDARELLORTNOC SLEVELFOREBMUN

1LTNC 1 3

2LTNC 2 4

Note: The controller address of  0 cannot be used since this is reserved
for a single controller configuration.

Level Tab

LEVEL
LEVEL
REBMUN

RELLORTNOC
LEVEL
TESFFO

FOREBMUN
STUPNI

FOREBMUN
STUPTUO

DIV-A 1 1LTNC 1 61 61

DUAL-A 2 1LTNC 2 61 61

DUAR-A 3 1LTNC 3 61 61

DIV-B 4 2LTNC 1 61 61

DUAL-B 5 2LTNC 2 61 61

DUAR-B 6 2LTNC 3 61 61

CT-B 7 2LTNC 4 61 61

4.5  PESA VP Configuration Conceptual Overview Cont:
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Note:  CNTL1 has 3 levels, therefore there is a level offset for each level
associated with that controller.  CNTL2 has 4 levels and there is a level
offset for each level associated with that controller.  Level offsets must be
unique per controller.  For example, A-VID and A-LAUD could not both
have a Level Offset of 1 since they are both associated with the same
controller.

Source Tab

ECRUOS DIV-A DUAL-A DUAR-A DIV-B DUAL-B DUAR-B CT-B

1CRSA 1 0 0 0 0 0 0

2CRSA 0 2 2 0 0 0 0

3CRSA 3 3 3 3 0 0 0

4CRSB 0 0 0 1 0 0 0

5CRSB 0 0 0 0 2 2 0

6CRSB 0 0 0 3 3 3 3

Note: 0 as an input indicates that the source is not defined on that level.

Destination Tab
NOITANITSED DIV-A DUAL-A DUAR-A DIV-B DUAL-B DUAR-B CT-B

1TSDA 1 0 0 0 0 0 0

2TSDA 0 2 2 0 0 0 0

3TSDA 3 3 3 3 0 0 0

4TSDB 0 0 0 1 0 0 0

5TSDB 0 0 0 0 2 2 0

6TSDB 0 0 0 3 3 3 3

Note: 0 as an input indicates that the Destination is not defined on that
level.

4.5  PESA VP Configuration Conceptual Overview Cont:

Multiple Ocelot Configuration Continued:
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Name Set Tab

TESEMANAMOOR

EMANPUORG EPYT

1CRSA CRS

2CRSA CRS

3CRSA CRS

1TSDA TSD

2TSDA TSD

3TSDA TSD

TESEMANBMOOR

EMANPUORG EPYT

4CRSB CRS

5CRSB CRS

6CRSB CRS

4TSDB TSD

5TSDB TSD

6TSDB TSD

TESEMANLLA

EMANPUORG EPYT

1CRSA CRS

2CRSA CRS

3CRSA CRS

4CRSB CRS

5CRSB CRS

6CRSB CRS

1TSDA TSD

2TSDA TSD

3TSDA TSD

4TSDB TSD

5TSDB TSD

6TSDB TSD

4.5  PESA VP Configuration Conceptual Overview Cont:

Multiple Ocelot Configuration Continued:
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Note:  In grouping the sources and destinations into a name set such as
ROOMA, the ROOMA name set may be selected from the PESA Virtual
Panel and only the sources and destinations for room A, i.e. controller 1,
are displayed.  Likewise, if the user chooses to view only ROOMB sources
and destinations, the ROOMB name set may be selected and the user will
view only those sources and destinations controlled by controller 2.  The
ALL name set is used to control and status all sources and destinations.

4.5  PESA VP Configuration Conceptual Overview Cont:

Multiple Ocelot Configuration Continued:
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5.1  Introduction

The following paragraphs describe the building of an example configura-
tion to assist the user in learning to build virtual panel configurations.  The
example configuration consists of one controller, four 16X16 levels (an
analog video level, an analog audio level, a digital video level, and a
digital audio level), sources, destinations, and three name sets.  Additional
configuration items are listed in tables included in the following para-
graphs.  To begin building the example configuration, open the PESA
Virtual Panel Configuration Program and select New from the File Menu.

NOTE:  The example configuration file is included as part of PESA Virtual
Panel Software Package.

5.2  Controllers

Selecting New from the File Menu will open a blank Virtual Panel Configu-
ration Screen.  To continue building the example configuration, select the
Controllers Tab (Figure 5-1) and then select the Controller Data Field.

Figure 5-1 Blank Controllers Tab
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To continue building the example configuration, enter the configuration
information found in Table 5-1 into the appropriate data fields.  Enter the
controller's name (OCELOT) in the Controller Data Field, the controller's
address (0) in the Controller Address Data Field, and the number of levels
(4) in the Numbers of Levels Data Field.

Table 5-1 Controllers

SRELLORTNOC

RELLORTNOC SSERDDARELLORTNOC SLEVELFOREBMUN

TOLECO 0 4

Once the example configuration's controller information is entered into the
appropriate data fields, the Controller Tab should appear similar to the
one shown in Figure 5-2.

Figure 5-2  Example Configuration Controllers Tab

5.2  Controllers Continued:
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5.3  Levels

To continue building the example configuration, select the Levels Tab
(Figure 5-3) and enter the configuration information found in Table 5-2 into
the appropriate data fields.  Enter the first level's name (RGBS) in the
Level Data Field and the level number (1) in the Number Data Field or
allow the configuration software to automatically assign the next available
number.  Select the OCELOT Controller from the Controller List (Control-
ler Data Field).  Once the level name and number are assigned and the
controller is selected, enter the level's offset (1) in the Level Offset Data
Field, the number of inputs (16) in the Number of Inputs Data Field, and
the number of outputs (16) in the Number of Outputs Data Field.

Figure 5-3  Blank Levels Tab

To continue configuring the example configuration's levels, enter the
levels configuration information found in Table 5-2 in the corresponding
Levels Tab data fields.
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Table 5-2  Levels

SLEVEL

LEVEL REBMUN RELLORTNOC
LEVEL
TESFFO

FOREBMUN
STUPNI

FOREBMUN
STUPTUO

SBGR 1 TOLECO 1 61 61

AA 2 TOLECO 2 61 61

DIVGID 3 TOLECO 3 61 61

SEA 4 TOLECO 4 61 61

Once the example configuration's levels information is entered into the
appropriate data fields, the Levels Tab should appear similar to the one
shown in Figure 5-4.

Figure 5-4  Example Configuration Levels Tab

5.3  Levels Continued:
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5.4  Sources

To continue building the example configuration, select the Sources Tab
(Figure 5-5) and enter the configuration information found in Table 5-3 into
the appropriate data fields.  Enter the first source's name (AVTR 1) in the
Source Data Field, the output number assignment for the RGBS Level (1)
in the RGBS Data Field, and the output number assignment for the AA
Level (1) in the AA Data Field.  Please note that the DIGVID Level and the
AES Level are not assigned output numbers for the source AVTR 1 and
the corresponding data fields are assigned the value "0" (unassigned).

Figure 5-5 Blank Sources Tab

To continue configuring the example configuration's sources, enter the
source configuration information found in Table 5-3 in the corresponding
Sources Tab data fields.
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Table 5-3 Sources

ELBATSECRUOS

SLEVEL

SECRUOS SBGR AA DIVGID SEA

1RTVA 1 1 0 0

2RTVA 2 2 0 0

3RTVA 3 3 0 0

4RTVA 4 4 0 0

5RTVA 5 5 0 0

KCALB 6 6 0 0

1TASD 0 0 41 41

2TASD 0 0 51 51

3TASD 0 0 61 61

1RTVD 0 0 1 1

2RTVD 0 0 2 2

3RTVD 0 0 3 3

4RTVD 0 0 4 4

5RTVD 0 0 5 5

6RTVD 0 0 6 6

1XHPARG 21 21 0 0

2XHPARG 31 31 0 0

3XHPARG 41 41 0 0

4XHPARG 51 51 0 0

5XHPARG 61 61 0 0

1CP 0 0 7 7

2CP 0 0 8 8

3CP 0 0 9 9

IGS 0 0 31 31

ATIDEIGS 11 11 0 0

BTIDEIGS 01 01 0 0

1NUS 0 0 01 01

2NUS 0 0 11 11

3NUS 0 0 21 21

1LLAW 7 7 0 0

2LLAW 8 8 0 0

3LLAW 9 9 0 0

5.4  Sources Continued:
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Once the example configuration's sources information is entered into the
appropriate data fields, the Sources Tab should appear similar to the one
shown in Figure 5-6.

Figure 5-6 Example Configuration Sources Tab

5.5  Destinations

To continue building the example configuration, select the Destinations
Tab (Figure 5-7) and enter the configuration information found in Table 5-
4 into the appropriate data fields.  Enter the first destination's name
(AVTR 1) in the Destination Data Field, the input number assignment for
the RGBS Level (1) in the RGBS Data Field, and the input number assign-
ment for the AA Level (1) in the AA Data Field.  Please note that the
DIGVID Level and the AES Level are not assigned input numbers for the
source AVTR 1 and the corresponding data fields are assigned the value
"0" (unassigned).

5.4  Sources Continued:
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Figure 5-7  Blank Destinations Tab

To continue configuring the example configuration's destinations, enter
the destination configuration information found in Table 5-4 in the corre-
sponding Destination Tab data fields.

5.5  Destinations Continued:
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Table 5-4 Destinations

ELBATSNOITANITSED

SLEVEL

SNOITANITSED SBGR AA DIVGID SEA

1RTVA 1 1 0 0

2RTVA 2 2 0 0

3RTVA 3 3 0 0

4RTVA 4 4 0 0

1NOMC 5 5 0 0

6NOMC 6 6 0 0

1FNOC 7 7 0 0

2FNOC 8 8 0 0

1NOMD 0 0 7 7

2NOMD 0 0 8 8

3NOMD 0 0 9 9

4NOMD 0 0 01 01

1RTVD 0 0 1 1

2RTVD 0 0 2 2

3RTVD 0 0 3 3

4RTVD 0 0 4 4

5RTVD 0 0 5 5

6RTVD 0 0 6 6

1LLAWD 0 0 11 11

2LLAWD 0 0 21 21

3LLAWD 0 0 31 31

1XHPARG 21 21 0 0

2XHPARG 31 31 0 0

3XHPARG 41 41 0 0

4XHPARG 51 51 0 0

5XHPARG 61 61 0 0

DIVDCQ 0 0 61 61

ATSET 01 01 0 0

BTSET 11 11 0 0

RABTSET 9 9 0 0

D1TIMXT 0 0 41 41

D2TIMXT 0 0 51 51

5.5  Destinations Continued:
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Once the example configuration's destinations information is entered into
the appropriate data fields, the Destinations Tab should appear similar to
the one shown in Figure 5-8.

Figure 5-8  Example Configuration Destinations Tab

5.6  Name Sets

To continue building the example configuration, select the Name Sets Tab
(Figure 5-9).  Three logical name sets (ALL, COMPNENT, and DIGITAL)
will be configured as part of the example configuration demonstration.
The ALL Name Set will be configured will all previously configured
sources and destinations assigned.  The COMPNENT Name Set will be
configured with the previously configured analog sources and destinations
assigned and the DIGITAL Name Set will be configured with the previ-
ously configured digital sources and destinations assigned.

5.5  Destinations Continued:
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Figure 5-9  Blank Name Sets Tab

To continue building the example configuration name sets, enter ALL in
the Name Set Data Field.  Select all sources from the Sources List and all
destinations from the Destinations List as shown in Table 5-5.  Once the
sources and destinations are selected, select Add to complete the con-
figuration of the ALL Name Set.

5.6  Name Sets Continued:
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Table 5-5 All Name Set

ELBATLLATESEMAN

SNOITANITSED SECRUOS

1RTVA TSD 1RTVA CRS

2RTVA TSD 2RTVA CRS

3RTVA TSD 3RTVA CRS

4RTVA TSD 4RTVA CRS

1NOMC TSD 5RTVA CRS

6NOMC TSD KCALB CRS

1FNOC TSD 1TASD CRS

2FNOC TSD 2TASD CRS

1NOMD TSD 3TASD CRS

2NOMD TSD 1RTVD CRS

3NOMD TSD 2RTVD CRS

4NOMD TSD 3RTVD CRS

1RTVD TSD 4RTVD CRS

2RTVD TSD 5RTVD CRS

3RTVD TSD 6RTVD CRS

4RTVD TSD 1XHPARG CRS

5RTVD TSD 2XHPARG CRS

6RTVD TSD 3XHPARG CRS

1LLAWD TSD 4XHPARG CRS

2LLAWD TSD 5XHPARG CRS

3LLAWD TSD 1CP CRS

1XHPARG TSD 2CP CRS

2XHPARG TSD 3CP CRS

3XHPARG TSD IGS CRS

4XHPARG TSD ATIDEIGS CRS

5XHPARG TSD BTIDEIGS CRS

DIVDCQ TSD 1NUS CRS

ATSET TSD 2NUS CRS

BTSET TSD 3NUS CRS

RABTSET TSD 1LLAW CRS

D1TIMXT TSD 2LLAW CRS

D2TIMXT TSD 3LLAW CRS

5.6  Name Sets Continued:
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To continue building the example configuration name sets, enter
COMPNENT in the Name Set Data Field below the ALL entry.  Select the
analog sources from the Sources List and the analog destinations from
the Destinations List as shown in Table 5-6.  Once the analog sources
and destinations are selected, select Add to complete the configuration of
the COMPNENT Name Set.

Table 5-6 Compnent Name Set

ELBATTNENPMOCTESEMAN

SNOITANITSED SECRUOS

1RTVA TSD 1RTVA CRS

2RTVA TSD 2RTVA CRS

3RTVA TSD 3RTVA CRS

4RTVA TSD 4RTVA CRS

1NOMC TSD 5RTVA CRS

6NOMC TSD KCALB CRS

1FNOC TSD 1XHPARG CRS

2FNOC TSD 2XHPARG CRS

1XHPARG TSD 3XHPARG CRS

2XHPARG TSD 4XHPARG CRS

3XHPARG TSD 5XHPARG CRS

4XHPARG TSD ATIDEIGS CRS

5XHPARG TSD BTIDEIGS CRS

ATSET TSD 1LLAW CRS

BTSET TSD 2LLAW CRS

RABTSET TSD 3LLAW CRS

To continue building the example configuration name sets, enter DIGITAL
in the Name Set Data Field below the COMPNENT entry.  Select the
digital sources from the Sources List and the digital destinations from the
Destinations List as shown in Table 5-7.  Once the digital sources and
destinations are selected, select Add to complete the configuration of the
DIGITAL Name Set.

5.6  Name Sets Continued:
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5.6  Name Sets Continued:

Table 5-7 Digital Name Set

ELBATLATIGIDTESEMAN

SNOITANITSED SECRUOS

1NOMD TSD 1TASD CRS

2NOMD TSD 2TASD CRS

3NOMD TSD 3TASD CRS

4NOMD TSD 1RTVD CRS

1RTVD TSD 2RTVD CRS

2RTVD TSD 3RTVD CRS

3RTVD TSD 4RTVD CRS

4RTVD TSD 5RTVD CRS

5RTVD TSD 6RTVD CRS

6RTVD TSD 1CP CRS

1LLAWD TSD 2CP CRS

2LLAWD TSD 3CP CRS

3LLAWD TSD IGS CRS

DIVDCQ TSD 1NUS CRS

D1TIMXT TSD 2NUS CRS

D2TIMXT TSD 3NUS CRS

Once the example configuration's name sets are configured, the Name
Sets Tab should appear similar to the one shown in Figure 5-10.
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5.6  Name Sets Continued:

Figure 5-10  Example Configuration Name Sets Tab

5.7  Example Configuration Save

Once the example configuration is completed, save the example configu-
ration as "Example" and make the example configuration the default
configuration.  Refer to the Save Section of this manual to resolve any
questions concerning the save operation.  Once the example configuration
is saved and selected to be the default configuration, exit from the PESA
Virtual Panel Configuration Program.
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6.1  Introduction

Selecting and clicking on PESA Virtual Panel in the PESA Virtual Panel
Program Group or selecting and clicking on the PESA Virtual Panel Icon
will open the PESA Virtual Panel Program. Once the PESA Virtual Panel
is open, the PESA Virtual Panel Screen will be displayed (Figure 6-1).
Note that the default configuration's (example configuration's) information
is displayed on the PESA Virtual Panel Screen.

Figure 6-1 PESA Virtual Panel Screen

General

There are up to four level keys, source keys, and destination keys on the
PESA Virtual Panel Screen. Additionally, there are keys and scrolling
menus on the PESA Virtual Panel Screen to facilitate the selection of
levels (Select All Key and Clear All Key), to select and take (Take Key)
presets/salvo, to select name sets, and to lock and unlock destinations
(Lock Key and Unlock Key).
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The Single Selection allows the selection of a single destination per
switch, while the Gang Selection allows the selection of multiple destina-
tions per switch. The selection of Create enables the user to create new
salvos, edit existing salvos, and delete existing salvos. The creation,
editing, and deletion of salvos is described in the Preset/Salvo Creation
Section of this manual.

6.2  Operation Menus

The main configuration menus on the PESA Virtual Panel Screen are File, Con-
figure, and Help. The File Menu provides access to the Open, Default, 3300/3500
Config Autoload, Force Load, and Exit menu functions (Figure 6-2). The Config-
ure Menu provides access to the Local Locking Only, Communications, Call
Remote, and Hangup functions (Figure 6-3). The Help Menu provides access to
the Contents and About functions (Figure 6-4).

Figure 6-2 File Menu Functions

Figure 6-3 Configure Menu Functions

6.1  Introduction Continued:
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Figure 6-4 Help Menu Functions

Open

Selecting Open in the File Menu will cause  the Open Screen (Figure 6-5)
to be displayed. The Open Screen enables the user to open existing
Virtual Panel Configurations (controller, levels, sources, destinations, and
name set information) into the PESA Virtual Panel Screen.

To open the desired configuration, click on the desired configuration name
or type in the desired configuration name into the File Name Data Field
and select Open.

Figure 6-5 Open Screen

Default

Selecting Default from the File Menu will open the default configuration
and update the PESA Virtual Panel Screen to reflect the default
configuration's functional information. The default configuration is a gen-
eral configuration that represents a PESA Ocelot Switching System con-
figuration.

6.2  Operation Menus Continued:
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3300/3500 Config Autoload

Selecting 3300/3500 Config Autoload from the File Menu will activate the
automatic loading, into the PESA Virtual Panel, of the current 3300/3500
Controller configuration.  Please note that the autoload function can only
utilized when a 3300 Controller or 3500 Controller is part of the routing
switcher system configuration.  The current 3300/3500 Controller configu-
ration will also be loaded when the PESA Virtual Panel is opened while
3300/3500 Config Autoload is selected.  Please note that when 3300/3500
Config Autoload is selected, it will stay selected until it is deselected.

Force Load

Selecting Force Load from the File Menu will force the PESA Virtual Panel
to re-load the current 3300/3500 Controller configuration.  Force Load is
only active when 3300/3500 Config Autoload is selected.

Exit

Selecting Exit from the File Menu will close the PESA Virtual Panel Pro-
gram and return you to the Windows™ desktop.

Local Locking Only

When Local Locking Only is selected from the Configure Menu, locks
made at the PESA Virtual Panel are not visible to the routing switcher
system and only affect the operation of the PESA Virtual Panel.  Please
note that when Local Locking Only is selected, it will stay selected until it
is deselected.  Local locking is useful when a high degree of source and
destination mapping is used in the system configuration.  It prevents a
lock of one destination from locking other destinations as well.

NOTE:  When implemented locks made at the PESA Virtual Panel do not
appear on the physical routing switcher control panels.

Communications

Selecting Communications from the Configure Menu will open the Config-
ure Settings Screen (Figure 6-6). The Configure Settings Screen enables
the user to select the system computer's communications port that will be
utilized for communications to and from the system controller via direct
connection or modem. Selections Com1 - Com4 are standard communica-
tions port selections, while the Simulator Selection allows the user to
practice using the PESA Virtual Panel without taking actual switches on
the routing switcher system.

6.2  Operation Menus Continued:
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Figure 6-6  Configure Settings Screen

Local Communications Configuration

To select the desired direct communications port, click on the desired
selection and then select OK. Selecting Cancel will abort the selection of a
communications port.

NOTE: If the incorrect communications port is selected, the switching
system may appear to be inoperative as the PESA Virtual Panel Program
tries unsuccessfully to communicate with the controller.

Remote Communications Configuration

The following paragraphs describe the initial configuration of dial-up mo-
dem communications link between the PESA Virtual Panel and a remote
system controller.  Please note that the following remote communications
configuration guide is meant to be example and does not cover all pos-
sible communication configurations.

To select the desired modem communications port, click on the communi-
cations port selection corresponding to the modem communications port
connection and then select Remote Access Enabled (Figure 6-7).

6.2  Operation Menus Continued:

Communications Continued:
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Figure 6-7 Configure Settings Screen (Remote Access Enabled)

Once Remote Access enabled is selected, select the communications
modem from the Modem Type List which corresponds to the local modem
in the routing switcher communications system.  (If there is not an exact
match on the Modems Type List, select Hayes Compatible (Figure 6-8).)
Please note that the Modem Init String Data Field and the Modem Hangup
Data Field are automatically updated to be compliant with the selected
modem.

Figure 6-8  Modem Type List Screen

6.2  Operation Menus Continued:

Communications Continued:
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Once the modem type is selected, select OK.  Selecting OK will open the
Virtual Panel Connect Screen (Figure 6-9).  Select New to continue the
configuration of the initial remote communications link.

Figure 6-9 Virtual Panel Connect Screen

Selecting New will open the New Connection Name Screen (Figure 6-10).
Enter the desired name and select OK to continue the configuration of the
remote communications link.

Figure 6-10 New Connection Name Screen

Selecting OK on the New Connection Name Screen will open the Remote
Connection Phone Number Screen (Figure 6-11).  Enter the correct phone
number for the remote routing switcher system remote connection and
select OK.

6.2  Operation Menus Continued:

Communications Continued:
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Figure 6-11 Remote Connection Phone Number Screen

Selecting OK on the Remote Connection Phone Number Screen will
activate the remote communication connection and will cause the local
modem to dial-up and connect to the remote modem. While the local
modem is attempting to establish the communications link, the Modem
Status Screen (Figure 6-12) will be displayed.  Once the link is estab-
lished, the Modem Status Screen will close and the PESA Virtual Panel
will be displayed.

Figure 6-12 Modem Status Screen

Call Remote

Selecting Call Remote from the Configure Menu will open the PESA
Virtual Panel Connect Screen (Figure 6-13).  The desired remote connec-
tion may be selected from the Name List or created using the New com-
mand.  If needed an existing remote connection configuration can be
edited using the edit command.  Remote connection configurations that
are no longer needed can be deleted using the Delete command.  Once
the desired remote connection is configured or selected, select Connect to
dial-up the selected remote communications connection.  Please note that
Call Remote is only selectable when remote access is enabled.

6.2  Operation Menus Continued:

Communications Continued:
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Figure 6-13 PESA Virtual Panel Connect Screen

Hangup

Selecting Hangup from the Configure Menu will disconnect the PESA
Virtual Panel from the remote communications connection.  Once the
remote communications connection is disconnected the Modem Offline
Screen (Figure 6-14) will be displayed.  Select OK to acknowledge the
modem offline condition and to return to the PESA Virtual Panel.  Please
note that Hangup is only selectable when remote access is enabled.

Figure 6-14 Modem Offline Screen

Contents

Selecting Contents from the Help Menu will open the PESA Virtual Panel's
help file. The help file functions in the same manner as the majority of
Windows™ help files. Once you are through referencing the PESA Virtual
Panel Help File, select File and Exit to return to the PESA Virtual Panel
Screen.

6.2  Operation Menus Continued:

Call Remote Continued:
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About

Selecting About from the Help Menu will open the PESA Virtual Panel
Information Screen. The PESA Virtual Panel Information Screen  displays
copyright and version information. To return to the PESA Virtual Panel
Screen, select OK.

6.3  PESA Virtual Panel Screen Areas and Buttons

The following paragraphs describe the display and button functions on the
PESA Virtual Panel Screen (Figure 6-15). The function of the Status
Display and the level, source, and destination buttons is described. Addi-
tionally, the function of the Clear All, Select All, Create, Take, Lock, and
Unlock Buttons is described. Also the functionality of the Name Set Select,
Single Selection, and Gang Selection are discussed.

Figure 6-15 PESA Virtual Panel Screen

6.2  Operation Menus Continued:
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Status Display

The Status Display displays the status, by level, of six destinations at a
time. The Status Display also displays the lock status of the destinations.
A lock symbol is displayed to the left of locked destination names. The
Status Display is automatically updated when switch actions are taken.
The Status Display can be scrolled by clicking on the left and right arrow
symbols, by using the scroll bar, and by clicking on a destination button.

Level Buttons

There are up to four level buttons displayed at one time on the PESA
Virtual Panel Screen. If more than four are included in the current configu-
ration, a scroll bar will appear next to the level buttons. The level names of
the configured levels are displayed on the level buttons. Selected level
buttons are displayed with a green background. Level buttons that are not
selected are displayed with a yellow background. Clicking on a level
button toggles the level between being selected/deselected.

Select All/Clear All Buttons

All levels can be selected/deselected by clicking on the Select All Button/
Clear All Button.

Source Buttons

There is one source button displayed on the PESA Virtual Panel Screen
for each of the current configuration's sources.  If the number of config-
ured sources exceeds the number of buttons that can be displayed at one
time, the source buttons can be scrolled.  The configured source names
are displayed on the source buttons. Activating a source button causes a
switch to be taken to the selected destination(s) for all active levels.

Destination Buttons

There is one destination button displayed on the PESA Virtual Panel
Screen for each of the current configuration's destinations. If the number
of configured destinations exceeds the number of buttons that can be
displayed at one time, the destination buttons can be scrolled. The config-
ured destination names are displayed on the destination buttons. The
destination buttons enable the selection of a single destination in the
Single Mode or the selection of multiple destinations in the Gang Mode.
Selected destination buttons are displayed with a green background. The
destination buttons not selected are displayed with a yellow background.
Unlocked destination names are displayed in blue text, while locked desti-
nation names are displayed in red text.

6.3  PESA Virtual Panel Screen Areas and Buttons Cont:



PESA VP

11/97
81905904080page 6.12

Section 6 Operation

Salvo/Preset Area

The Salvo/Preset Area of the PESA Virtual Panel Screen contains the
Create Button, the Take Button, and the Configured Salvos List. Clicking
on the Create Button accesses the PESA Virtual Panel Preset Screen.
The PESA Virtual Panel Preset Screen's function is described in the
Create Salvo/Preset Section of this manual. The Configured Salvos List
enables the selection of a pre-configured salvo to be executed or taken.
The Take Button enables the execution of the selected salvo.

Name Set List

The Name Set List contains the list of all the current configuration's name
sets and enables the selection of the desired name set from the list.  The
name sets enable the rapid configuration of the controlled destinations
and sources.

Lock/Unlock Buttons

The Lock Button enables the locking of a selected destination or destina-
tions, to protect the selected destination(s) from unwanted switch actions.
Locked destination names are displayed in red and a lock symbol is dis-
played to the left of the destination names in the Status Display. The
Unlock Button enables the unlocking of locked destination(s).  Please note
that locks occur on the physical controller or just on the PESA Virtual
Panel depending on Local Lock Mode.

Single/Gang Selections

The Single Selection enables the selection of one destination at a time. To
select a destination in the Single Mode, click on the desired destination
button. The destination selection will be automatically updated to the
destination corresponding to the last selected destination button while in
the Single Mode. The Gang Selection enables the selection of multiple
destinations at a given time. To select the desired destinations in the
Gang Mode, click on the desired destination buttons. Please note that
while in the Gang Mode, destinations will stay selected until they are
deselected. To deselect destinations in the Gang Mode, click on the
selected destination buttons.

6.3  PESA Virtual Panel Screen Areas and Buttons Cont:
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6.3  Follow Switch Example

To execute a follow switch, first select all levels and then select a destina-
tion or group of destinations (gang). Once all levels and the desired
destination(s) are selected, select the source to be switched. When the
source is selected the switch will be taken and the Status Display of the
PESA Virtual Panel Screen will be updated to reflect the latest control
panel status.

Analog Levels Follow Switch

Using the sample configuration's source and destination information,
select the destination "AVTR 1" and then select the source "AVTR 2".
When the source "AVTR 2" is selected the follow switch occurs and the
Status Display of the PESA Virtual Panel Screen is updated as shown in
Figure 6-16 to reflect the switch.

Figure 6-16 Analog Levels Follow Switch
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6.3  Follow Switch Example Continued:

Digital Levels Follow Switch

Using the sample configuration's source and destination information,
select the destination "DMON 1" and then select the source "DSAT 1".
When the source "DSAT 1" is selected the follow switch occurs and the
Status Display of the PESA Virtual Panel Screen is updated as shown in
Figure 6-17 to reflect the switch.

Figure 6-17 Digital Levels Follow Switch
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6.4  Breakaway Switch Example

To execute a breakaway switch, select the desired destination(s). Once
the destination(s) are selected, select the levels which are to be switched
and then select the source to be switched. When the source is selected
the switch will occur and the Status Display of the PESA Virtual Panel
Screen will be updated to reflect the latest control panel status.

Analog Levels Breakaway Switch

Using the sample configuration's level, source, and destination informa-
tion, select the destination "AVTR 3". Once the destination is selected,
select the level "AA" and then the source "BLACK". When the source
"BLACK" is selected the breakaway switch occurs and the Status Display
of the PESA Virtual Panel Screen is updated as shown in Figure 6-18 to
reflect the switch.

Figure 6-18 Analog Levels Breakaway Switch
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Digital Levels Breakaway Switch

Using the sample configuration's level, source, and destination informa-
tion, select the destination "DMON 2". Once the destination is selected,
select the level "DIGVID" and then the source "DVTR 5". When the source
"DVTR 5" is selected the breakaway switch occurs and the Status Display
of the PESA Virtual Panel Screen is updated as shown in Figure 6-19 to
reflect the switch.

Figure 6-19 Digital Levels Breakaway Switch

6.4  Breakaway Switch Example Continued:
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6.5  Lock/Unlock Example

The lock function of the PESA Virtual Panel enables the user to lock the
selected destination(s) in order to protect the selected destination(s) from
unauthorized switch actions. To lock a selected destination, select the
destination to be locked and then select lock. For example, select the
destination "AVTR 7" and then select the lock button. When lock is se-
lected, the selected destination will be locked and the Status Display of
the Virtual Control Panel Screen will be updated to show the lock status of
the selected destination (Figure 6-20).

 

Figure 6-20 Locked Destinations

The unlock function of the PESA Virtual Panel enables the user to unlock
the selected locked destination(s). To unlock a destination, select the
destination to be unlocked and then select unlock. For example, select the
destination "AVTR 7" and then select the unlock button. When unlock is
selected, the selected destination will be unlocked and the Status Display
of the Virtual Control Panel Screen will be updated to show the new status
of the selected destination (Figure 6-21).
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Figure 6-21 Unlocked Destinations

6.6  Single Destination Select Example

To select a single destination at a given time, select Single as shown in
Figure 6-22. The Single Function enables the selection of only one desti-
nation at a time. "DMON 1" is the selected destination.

6.5  Lock/Unlock Example Continued:
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Figure 6-22 Single Destination Select

6.7  Gang (Multiple) Destination Select Example

To select multiple destinations at a given time, select Gang as shown in
Figure 6-23. The Gang Function enables the selection of one or more
destination at a time. "AVTR 1", "AVTR 2", "AVTR 3", "AVTR 4", "CMON
1", "CMON 6", "DMON 3", "DMON 4", "DVTR 1", "DVTR 2", "DVTR 3",
and "DVTR 4" are the selected destinations.

6.6  Single Destination Select Example Continued:
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Figure 6-23 Gang Destination Select

6.8  Salvo Take Example

To take (execute) a pre-configured salvo, select the salvo to be executed
from the drop list box (located to the left of the Take Button).

6.7  Gang (Multiple) Destination Select Example Cont:
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Figure 6-24 PESA Virtual Panel Screen (Alpha Salvo Selected)

To complete the execution of the selected salvo, select the Take Button.
Selecting or clicking on the Take Button will open the PESA Virtual Panel
Information Screen (Figure 6-25). Select OK to execute the selected
salvo.

Figure 6-25 PESA Virtual Panel Information Screen

6.8  Salvo Take Example Continued:
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6.9  Create Salvo/Preset

Selecting Create on the PESA Virtual Panel Screen will open the PESA
Virtual Panel Preset Screen. The PESA Virtual Panel Preset Screen
contains the functions necessary to create, save, and delete salvos. Also
included is a capture screen function which enables the capturing of the
current status of the Status Display on the PESA Virtual Panel Screen.

6.10  PESA Virtual Panel Preset

The following paragraphs describe the display and button functions on the
PESA Virtual Panel Preset Screen (Figure 6-26). The function of the
Preset Display, Sources List, Destinations List, and of each button is
discussed.

Figure 6-26 PESA Virtual Panel Preset Screen
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Preset Display

The Preset Display enables the rapid and intuitive configuration of presets
and salvos.  The first column allows the configuration or plug-in of se-
lected destinations from the Destinations List. The other columns (one
column per level name) allow the configuration or plug-in of selected
sources.  Scroll bars enable the selection of the area of the Preset Display
which is displayed.

Load/Store Salvo Button

The Load/Store Salvo Button enables the loading of a pre-configured
salvo into the PESA Virtual Panel's preset. To load a salvo into the preset,
scroll through the Salvo List and highlight the desired salvo name. Once
the desired salvo name is selected, the PESA Virtual Panel Information
Screen will be displayed. To complete the loading of the selected salvo
into the preset, select OK.

Save to Salvo Button

The Save to Salvo Button allows the PESA Virtual Panel's preset informa-
tion to be saved as a salvo. To save the preset information as a salvo,
select Save to Salvo. Selecting Save to Salvo will open the Preset Save
Screen (Figure 6-27). Enter the desired salvo name into the Save Preset
As Data Field and then select OK. The preset information will then be
saved in a salvo data file under the desired name.

Figure 6-27 Salvo Save Screen

6.10  PESA Virtual Panel Preset Continued:
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Delete Salvo Button

The Delete Salvo Button enables the deletion of existing salvo configura-
tion files. To delete a salvo configuration file, select Delete Salvo. Select-
ing Delete Salvo will cause the Preset Delete Screen (Figure 6-28) to be
displayed. Select the salvo(s) to be deleted from the Salvo List and then
select Delete. Once all of the desired salvos are deleted, select Done to
return to the PESA Virtual Panel Preset Screen.

Figure 6-28 Preset Delete Screen

Sources List

The Sources List enables the selection of source names to configure
presets. The Source List contains the names of all configured sources in
the current name set. Selected source names can either be dragged and
dropped into the desired Preset Display level column matrix positions or
double-clicked on. The Sources List can be scrolled either by clicking on
the Sources List arrow up or arrow down symbols or by using the Sources
List scroll bar and dragging it up or down until the desired source name is
visible.

6.10  PESA Virtual Panel Preset Continued:
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Figure 6-29 Source Select

Destinations List

The Destinations List enables the selection of destination names to config-
ure presets. The Destinations List contains the names of all configured
destinations in the current name set. Destinations selected from the Desti-
nations List can either be dragged and dropped into the desired row in the
Destinations Column or selected destinations can be double-clicked on.
The Destinations List can be scrolled either by clicking on the Destinations
List arrow up or arrow down symbols until the desired destination name is
visible or by using the Destinations List scroll bar and dragging it up or
down until the desired destination name is visible.

6.10  PESA Virtual Panel Preset Continued:

Sources List Continued:
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Figure 6-30 Destination Select

Clear All Button

Selecting Clear All will clear all preset information (switches) from the
PESA Virtual Panel's preset.

Clear Selected Button

Selecting Clear Selected will clear all selected (highlighted) information
from the PESA Virtual Panel's preset.

Take All Button

Selecting Take All will cause all switch action information contained in the
PESA Virtual Panel's preset to be taken to the PESA Routing Switcher
System.

Destinations List Cotinued:

6.10  PESA Virtual Panel Preset Continued:
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Take Selected Button

Selecting Take Selected will cause the selected (highlighted) switch action
information contained in the PESA Virtual Panel's preset to be taken to
the PESA Routing Switcher System.

Capture Status Button

Selecting Capture Status loads the current routing switcher status into the
preset (Figure 6-31).

Figure 6-31 PESA Virtual Panel Preset Screen

Exit Button

Selecting the Exit Button will return you to the PESA Virtual Panel Screen.

6.10  PESA Virtual Panel Preset Continued:
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6.11  Preset Creation Drag and Drop Method

To create presets using the drag and drop method, refer to the following
instructions.

To load a destination into preset, select a destination from the Destination
List and drag it over to the desired destination column position.

To load a follow switch, select a source from the Source List and drag it
over to a column adjacent to the destination you want to switch.

To load a breakaway switch, first select the desired levels next to the
destination to be switched. Then select a source from the Source List and
drag it over to the selected area.

Repeat the above steps until all desired switches are configured in the
Preset Display.

6.12  Preset Creation Double-Click Method

To create presets using the double-click method, refer to the following
instructions.

To load a destination, double-click on a destination in the Destinations
List.

To load a follow switch, first select the destinations to be switched in the
preset display. Then double-click on the source you would like to switch.

To load a breakaway switch, select the desired levels adjacent to the
destinations to be switched. Then double-click on the source you would
like to switch.

Repeat the above steps until all desired switches are configured in the
Preset Display.


